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SAFETY WARNING 
Always observe standard safety precautions during installation, operation and maintenance of this 
product. Read the installation instructions before connecting the unit to its power source.  There are no 
user serviceable parts inside the unit. To avoid the possibility of electric shock, the user should not 
perform any adjustment, maintenance or repairs to an opened unit.  Do not work on the product or 
connect or disconnect cables during periods of lightning activity. Ultimate disposal of this product should 
be handled according to all national laws and regulations. 

WARRANTY 
Unless otherwise specified, all products presented in this user's guide are warranted against defects in 
material and workmanship for a period of one year from the date of sale to the initial purchaser. PANDUIT 
Corp. warrants that its firmware designed by PANDUIT Corp. for use with the product will execute its 
functions when properly installed in the product for one year from the date of sale to the initial purchaser. 
PANDUIT Corp. does not warrant that the operation of the product or the firmware will be uninterrupted or 
error-free. During the warranty period PANDUIT Corp. will, at its discretion, either repair or replace 
products that prove to be defective. For warranty service or repair, the product claimed to be defective 
must be returned to a service facility designated by PANDUIT Corp. Buyer shall prepay all the shipping 
charges to PANDUIT Corp. and if, in the opinion of PANDUIT Corp., the product is defective, PANDUIT 
Corp. shall pay shipping charges to return the product to Buyer. However, Buyer shall pay all shipping 
charges, duties and taxes for products returned to PANDUIT Corp. from another country.  
 
The products presented in this user's guide are not designed, intended, authorized or warranted to be 
suitable for use as components in systems used in any life support or critical applications, including but 
not limited to, any applications intended to support or sustain life, any medical applications, any systems 
used for commercial transportation or nuclear facilities or any other applications where product failure 
could lead to personal injury, death or catastrophic property damage. Accordingly, PANDUIT Corp. 
disclaims any and all liability arising out of the use of the products in any life support or critical application. 
If buyer uses the product in any life support or critical application, buyer, and not PANDUIT Corp, 
assumes full responsibility for such use. Further, PANDUIT Corp. reserves the right to refuse to service 
any product used in any life support or critical application, and disclaims any and all liability arising out of 
the PANDUIT’S service or refusal to service such product. 
 
The foregoing warranty shall not apply to defects resulting from, buyer-supplied firmware or unauthorized 
interfacing, modification or misuse of the product, operation outside of the environmental specifications 
for the product, or improper or inadequate site preparation or maintenance by Buyer.  
 
NO OTHER WARRANTY IS EXPRESSED OR IMPLIED. PANDUIT CORP. SPECIFICALLY 
DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.  
 
THE REMEDIES PROVIDED HEREIN ARE BUYER'S SOLE AND EXCLUSIVE REMEDIES. PANDUIT 
CORP. SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT OR OTHER LEGAL 
THEORY.   
 
Unless otherwise specified by PANDUIT Corp., opening of this product by unauthorized personnel will 
void this warranty. 

TRADEMARKS 
DPoE™ and Ultimate ID are trademarks of PANDUIT Corp. All other trademarks are the property of their 
respective owners. 
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OVERVIEW 
The DPoE™ Compact 8 Midspan provides a reliable and cost-effective solution for Power over Ethernet 
(PoE) applications, complaint with the IEEE 802.3af-2003 specification and beyond. Each DPoE™ 
Compact 8 Midspan allows centralized powering of up to 8 devices, such as Internet Protocol-based (IP) 
telephones, Network Security Cameras, or Wireless Access Points, over the same cabling used to 
provide the Ethernet connectivity. By eliminating separate power connections to each of the devices, the 
DPoE™ Compact 8 Midspan provides a more scalable, cost-effective solution, particularly in cases where 
local powering is impractical.  
 
The DPoE™ Compact 8 Midspan may be used as a standalone device. It can also be configured and 
monitored from a centralized PANDUIT® DPoE™ Element Manager software tool. This management 
system allows network operators to remotely perform routine maintenance and monitoring of any DPoE™ 
Compact 8 Midspans in their network. The DPoE™ Element Manager allows operators to graphically view 
and monitor DPoE™ device status, fault conditions and per-port power consumption. In addition, the 
DPoE™ Element Manager allows the operator to designate power priority to individual ports within each 
DPoE™ device. This vertical capability allows the DPoE™ Element Manager pre-configured information 
to guarantee that mission-critical devices remain operational in the event of low-power conditions.  The 
DPoE™ Compact 8 Midspan can also be easily integrated into higher-level Network Management System 
(NMS) through the available management information base (MIB).  
 
 
 

 
 
 
 
 
 
 

NOTE: DPoE™ Compact 8 Midspan cannot be used for analog or non-Ethernet devices. 
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Features and Benefits 
The following table highlights some of the capabilities of the DPoE™ Compact 8 Midspan along with the 
tangible benefit to the network operator. 
 

DPoE™ Compact 8 Midspan Feature Benefit 
Provides PoE power for up to 8 devices from a 
convenient centralized location. 

By using PoE, a network operator can cost-
effectively deliver power to PoE powered devices 
(PD) up to 100 m (328 ft.) from the DPoE™ 
Compact 8 Midspan. Powering from a 
centralized location removes the need to power 
each device separately, eliminates the need for 
separate Uninterruptible Power Supply (UPS) for 
critical devices, and enables centralized power 
management by the network operator. 

IEEE 802.3af-2003 Compliant Many currently available PoE powering options 
are not standards-based, thus requiring 
coordination between each device’s power 
needs and the technical capabilities of the in-line 
powering unit.  

Support for 802.3af-2003 standard Any port on the DPoE™ Compact 8 Midspan can 
support the 802.3af-2003 standard powering 
scheme. Ethernet devices that do not require 
PoE powering may also be mixed in the same 
power midspan. 

1 GbE data transmission rate. (10/100/1000) Beyond the current IEEE 802.3af-2003 standard 
the DPoE™ Compact 8 Midspan supports a 1 
GbE data transmission rate. (10/100/1000) 

Full IEEE 802.3af-2003 power to all ports plus 
DOUBLE the power headroom as required 

All ports on the power midspan are capable of 
delivering the full PoE power specified by the 
IEEE 802.3af-2003 standard (15.4 Watts at the 
PSE). The DPoE™ Compact 8 Midspan has 
plenty of power headroom enabling it to supply 
DOUBLE the power at every port (up to 32 
Watts), which is well beyond what the standard 
specifies. 

Increased System Reliability through efficient 
thermal design 

The DPoE™ Compact 8 Midspan does not 
require the use of an internal fan. Fans can 
reduce the system reliability.  

Power Prioritization using the DPoE™ Element 
Manager 

In the event of a power lag or interruption a 
Network Management System (NMS) monitoring 
the power midspan can execute pre-established 
port priorities to ensure mission-critical ports on 
the network continue to receive PoE power as 
long as possible when backed-up through a UPS 
(Uninterruptible Power Supply). 
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Easier Local Management using visual prompts Multi-colored LEDs on the DPoE™ Compact 8 
Midspan allow technicians to instantly know the 
status of each port. Additional LEDs indicate 
management and power midspan status. 
Ultimate Identification labels on the front the 
system allow the technician to note the device 
number, the port number and wiring scheme 
information for both the Switch and Powered 
Device sides of the power midspan. 

Easier Remote Management using the bundled 
DPoE™ Element Manager  

The DPoE™ Element Manager allows network 
operators to easily view and manage a network 
of DPoE™ Compact 8 Midspans using the 
industry standard Simple Network Management 
Protocol (SNMP) to exchange management 
information between network devices. 

Easier Installation The DPoE™ Compact 8 Midspan is fast and 
easy to install permitting entry-level deployments 
to scale up as the user’s needs grow. 

 
 

 
 
The DPoE™ Compact 8 Midspan supports standard IEEE 802.3af-2003 devices. 
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Figure 1a: DPoE™ Compact 8 Midspan (Front View) 

 
 
 
 

 
Figure 1b: DPoE™ Compact 8 Midspan (Front View) 

 
 
 
 
 
 



PANDUIT® DPoE™ Compact 8 Midspan  Part Number: PN424E  

  
  9  

 
Figure 1c: DPoE™ Compact 8 Midspan (Front and Rear LED Detail) 

 
 
 
 
 

 
Figure 2: DPoE™ Compact 8 Midspan (Rear View) 
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INSTALLATION  
 
The PANDUIT® DPoE™ Compact 8 Midspan requires a direct connection to a nominal 48VDC supply. 
An individual power supply is available separately from PANDUIT (Part # DPOEPWRB120Y).  Installation 
instructions for the available power supply are included with that product. PANDUIT Corp. provides the 
user with the flexibility to select multiple power supply product options tailored to their specific needs. 
Please refer to the section in this User Guide describing Powering Requirements for a complete selection 
of available Power Supplies.  
 
WARNING: Only trained and qualified service personnel should install or service DPoE™ 

Compact 8 Midspans 
 
WARNING: Before installing or servicing DPoE™ Compact 8 Midspans or communication 

wiring, be aware of the hazards with the associated electrical circuitry. 
 
DPoE™ Compact 8 Midspan Shipping Package Contents 
 
Each DPoE™ Compact 8 Midspan is shipped in a box, which includes the following: 
 

Table 1: DPoE™ Compact 8 Midspan Package Contents 
 
Item Quantity Notes 
DPoE™ Compact 8 Midspan 1  

DPoE™ Compact 8 Midspan Installation 
Instructions 

1 Part # PN420 

DPoE™ Compact 8 Midspan Installation 
Worksheet 

1 Part # PN377 

DPoE™ Compact 8 Midspan Support Tools CD-
ROM  
 

1 Includes DPoE™ Element 
Manager software. 
DPoE™ Compact 8 Midspan 
Users Guide (PN424) 

Ultimate ID labels 4 position blank 2 Four position, blank, write-on 
labels for easy port identification. 
Replacement labels P/N 
UIWOL4 

Ultimate ID covers 4 position clear 2 Four position, clear, label covers 
to protect the port labels. 
Replacement covers P/N 
UILC4C 

Power Connector with 10’ conductor leads for 
connection to a 48 volt DC power supply  

1 For optional use terminating the 
power connection of the power 
midspan to a DPOE Power 
System Chassis.  

Butt Splice, 16-14 AWG, vinyl insulated 2 Part # BSV14X for connecting 
the optional power connector 
leads. 

Self Adhesive Feet 4 For tabletop installation use the 
included four self-adhesive feet. 

 
Verify the above contents arrived in good condition. If not, contact PANDUIT Customer Service by phone 
at 800-777-3300. 
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Physical Mounting Options 

 
Figure 3: DPoE™ Compact 8 Midspan (Table Top View)  

 

 
 
Figure 4: DPoE™ Compact 8 Midspan shown with optional Wall Mount Bracket  
The DPoE™ Compact 8 Midspan Wall Mount Bracket is available separately from PANDUIT (Part # 
DPOEWM8B). 
 
 
ATTENTION: Observe precautions for handling electrostatic sensitive electronic devices when 

installing this product. Ensure that you are properly grounded with a wrist strap or 
equivalent while making connections to this product. 
 
Never make any connections to product when power is being applied. 
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DPoE™ Compact 8 Midspan Wall Mount Shipping Package Contents 
 
Each DPoE™ Compact 8 Midspan Wall mount (Part # DPOEWM8B) is shipped in a box, which includes 
the following: 
 

Table 2: DPoE™ Compact 8 Midspan Wall Mount Package Contents 
 
Item Quantity Notes 
DPoE™ Compact 8 Midspan Wall Mount Bracket 1 Part # DPOEWM8B 
DPoE™ Compact 8 Midspan Wall Mount 
Installation Kit 

Includes 
items below  

Part # DPOEWM8B-KIT 

Wall Mount Installation Instructions 1 PN423 
Pan-TY Cable tie 1 Part # PLT1.5I 
#6 X 2 inch Drywall Screw 2  
#8 X 1.25 Sheet Metal Screw 2  
Wall Anchor 2  

 
Verify the above contents arrived in good condition. If not, contact PANDUIT® Customer Service by 
phone at 800-777-3300.  
 
Wall Mounting Instructions 
1. Record the MAC address, printed on a sticker on the back of the DPoE™ Compact 8 Midspan, by 

writing it in the space provided on the included Installation Worksheet (Part # PN377). 
2. Follow the Wall Mount Installation Instructions (Part # PN423) included in the DPoE™ Compact 8 

Midspan Wall Mount package.   
 

 
Figure 5: DPoE™ Compact 8 Midspan (shown with optional DPoE™ Compact 8 

Midspan 1RU Shelf) 
The DPoE™ Compact 8 Midspan 1RU Shelf is available separately from PANDUIT (Part# DPOESHELF). 
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DPoE™ Compact 8 Midspan 1RU Shelf Shipping Package Contents 
 
Each DPoE™ Compact 8 Midspan 1RU Shelf is shipped in a box, which includes the following: 
 

Table 3: DPoE™ Compact 8 Midspan 1RU Shelf Package Contents 
 
Item Quantity Notes 
DPoE™ Compact 8 Midspan 1RU Shelf 1 Part # DPOESHELF 
DPoE™ Compact 8 Midspan 1RU Shelf Installation 
Kit 

Includes 
items below  

Part # DPOESHELF-KIT 

Shelf Installation Instructions 1 PN421 
Ground Strap Kit 1 AGPJ148 
Green / Yellow grounding strap 1  

Bonding Nut 10/32 1 PBGN1032 
Screws,  12-24 x 0.50 Phillips Indented Hex Pack of 6  
Screws,  M6x1.0x16 Phillips Indented Hex Pack of 6  

 
Verify the above contents arrived in good condition. If not, contact PANDUIT Customer Service by phone 
at 800-777-3300.  
 
Shelf Mounting Instructions 
 
1. Record the MAC address, printed on a sticker on the back of the DPoE™ Compact 8 Midspan, by 

writing it in the space provided on the included Installation Worksheet (Part # PN377). 
2. Using four of the enclosed metric or English screws, as appropriate, install the DPoE™ Compact 8 

Midspan Shelf into the 19” rack at the planned rack position.  
3. Using a screw and bonding nut from the Grounding Kit attach the green and yellow striped grounding 

strap to the shelf via the unthreaded hole at the right rear of the shelf.  
4. Attach the loose end of the grounding strap to the rack within the same position as the shelf. 
5. Next, install a DPoE™ Compact 8 Midspan into one of the three mounting positions.  Align the power 

midspan using the slotted rail guides. Pull the power midspan all the way to the back of the shelf 
using the shelf mounting handle on the rear of the power midspan. Using the shelf captive 
thumbscrew firmly secure the power midspan into the rear mounting of the shelf. 

 
Grounding Requirements 
 
It is recommended that the DPoE™ Compact 8 Midspan 1RU Shelf be connected to an earth ground. 
Bypassing a grounding system will impede the rack mounting system’s overall performance.  
 
 
NOTE: The supplied screws are part of a grounding system to ensure that the DPoE™ 

Compact 8 Midspan 1 RU Shelf is properly grounded to the rack.   
 
USE ONLY THE SUPPLIED SCREWS TO ATTACH THE SHELF TO THE RACK. 
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DPoE™ Modular 8 Port Passive Module 

  
 

Figure 6: DPoE™ Modular 8 Port Passive Module 
 
The DPoE™ Modular 8 Port Passive Module is available separately from PANDUIT (Part # 
DPOEPL8BU). It provides convenient 8-position passive patch panel integration into the DPoE™ 
Compact 8 Midspan 1RU Shelf. The DPoE™ Modular 8 Port Passive Module can be installed into either 
the DPoE™ Wall Mount Bracket (Part # DPOEWM8B) or into any slot of the DPoE™ Compact 8 Midspan 
1RU Shelf (Part # DPOESHELF).  
 
DPoE™ Modular 8 Port Passive Module Shipping Package Contents 
 
Each DPoE™ Modular 8 Port Passive Module (Part # DPOEPL8BU) is shipped in a box, which includes 
the following: 
 

Table 4: DPoE™ Modular 8 Port Passive Module Package Contents 
 
Item Quantity Notes 
DPoE™ Modular 8 Port Passive Module Includes 

items below  
Part # DPOEPL8BU 

DPoE™ 8 Port Passive Module Tray 1  
DPoE™ Modular 8 Port Passive Module Installation 
Kit 

Includes 
items below  

Part # DPOEPL8BU -KIT 

DPoE™ Modular 8 Port Passive Module Installation 
Instructions 

1 PN422 

4 position Mini-Com Patch Panel faceplate 2 P/N UICPPL4IBU-B 
Ultimate ID labels 4 position blank 2 P/N UIWOL4 
Ultimate ID cover 4 position clear 2 P/N UILC4CL 
 
Verify the above contents arrived in good condition. If not, contact PANDUIT Customer Service by phone 
at 800-777-3300.  
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NOTE: It is necessary to initially dress the terminated cables through the back of the mounting 

hardware (DPOESHELF shown below). Then, snap the MINI-COM modular jacks into the 
faceplate of the DPoE™ Modular 8 Port Passive Module. Finally, slide the Passive 
Module into the mounting hardware. 

 

 
 

Figure 7: DPoE™ Modular 8 Port Passive Module  with  DPoE™ 1RU Shelf 
 
Data Connection and Data + Power Connections 
 

 
 
 
 
 
 

 
 
 
 

NOTE: The DPoE™ Compact 8 Midspan should only be used with high quality patch cords 
like the PANDUIT line of TX6™ PLUS Category 6 Patch Cords.  Some low-grade, non-
standard patch cords may exhibit difficulty with insertion or in some instances may not 
seat at all into the RJ45 jack port. It is highly recommended to always use high quality, 
mechanically sound patch cords. All TX6™ PLUS Category 6 Patch Cords exceed the 
TIA/EIA-568-B.2-1 Category 6 standards. 
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INSTALLATION 
ADVISORY: 

Ensure that cabling to powered devices is protected from inductive coupling from 
nearby power cables and other sources. 
 
Ensure that powered devices are properly installed and grounded (according to 
manufacturer’s recommendations), and all the cabling and connections are 
isolated from external surges. 

 
 

NOTE: When installing cabling and making connections to the DPOE8S2XG, follow 
all local standards as well as the applicable TIA-942 standards and IEEE 
802.3 (Ethernet) standards. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 8: Data Connection and Data + Power Connections 
 
Powering Requirements 
 
The DPoE™ Compact 8 Midspan is powered by a separate DC power supply. PANDUIT provides the 
user with the flexibility to select multiple power supply product options tailored to their specific needs. A 
country specific main power cord needs to be ordered along with the selected power supply. The power 
product options are listed in the table below. 
 

Table 5: Individual Power Supplies Available from PANDUIT 
 
Part Numbers Description 
DPOEPWRB120Y 120 watt power supply - 48 volt output 
DPOEPWRCU Power chassis - supports 3 rectifiers  
DPOEPWRR500 500 watt rectifier for use in the DPOEPWRCU chassis 
DPOEPWRR1250 1250 watt rectifier for use in the DPOEPWRCU chassis 
DPOEPWRF7.5 7.5 amp fuse (package of 8) 
DPOEPWRF5 5 amp fuse (package of 4) 
CORD-S15 Power cord for North America 
CORD-J15 Power cord for Japan 
CORD-A Power cord for Australia 
CORD-E Power cord for Europe 
CORD-U Power cord for the U.K. 
 
 

 

 
 

To Powered Ethernet Device 
(Data + Power) 

From Ethernet Switch 
(Data Only) 
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Figure 9: DPoE™ Compact 8 Midspan Rear Power Connection 

 
WARNING: The DC power supply pins are polarized therefore the power connector is keyed to 

prevent incorrect attachment of the DC power feed. 
 
The DPoE™ Compact 8 Midspan will not function if power polarity is improperly 
wired.    

 
Applying a power Source to the DPoE™ Compact 8 Midspan        
 
The DPoE™ 120 Watt Power Supply (Part # DPOEPWRB120Y) is equipped with a 10 foot output power 
lead that terminates in a keyed DC power plug that will mate with the power connector receptacle on the 
back of the panel. Plug the keyed DC power connector into the back of the DPoE™ Compact 8 Midspan. 
Plug the power supply into an AC receptacle. 

 
Figure 10: DPoE™ Compact 8 Midspan Rear Power Plug Connection 

 
 

DPoE™ EUROPEAN 
(EMC) WARNING: 

Product is not intended for use in a residential environment. Use of this product 
in residential areas may cause electromagnetic interference. 
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LED Indications During Power Up Sequence                   
 
Once power is applied to the unit, the DPoE™ Compact 8 Midspan will go through its power up 
sequence. The following table describes the behavior of the unit as viewed from the front and the back. 
 

 
 

Figure 11: DPoE™ Compact 8 Midspan (Front and Rear LED Detail) 
 
The DPoE™ Compact 8 Midspan displays system, network and port status through the use of nine LEDs 
on the front and one on the rear of each power midspan.  There is one SYSTEM status LED in the middle 
of the center of the front of the power midspan. Eight individual port status LEDs are grouped vertically in 
two sets of four down the center of the front of the power midspan. One network status LED on the rear of 
the unit is located next to the management port.  These LEDs enable the technician to see at a glance if 
either the ports or the power midspan itself is functioning normally or in an alarm condition.  
 

Table 6: DPoE™ Compact 8 Midspan Power Up Sequence 
 

LED Behavior During  
Power Up Sequence as  

viewed from the  
FRONT 

LED Behavior During 
Power Up Sequence as 

viewed from the  
REAR 

SYSTEM LED PORT LEDs NETWORK LED 
Two seconds after power is applied 
to the unit the System LED will 
illuminate RED and continue to be 
on for five seconds then pulse 
(50mS) and remain on for another 
three seconds.  

 
Port LEDs are OFF  

 
When power is applied to 
the unit the Network LED 
will immediately illuminate 
RED and continue to be on 
during the entire power up 
sequence.  
 
 
After the power up 
sequence the Network 
LED will turn off and 
remain off until there is 
activity at the network jack.  

 
The System LED will flash on and 
off AMBER and continue flashing 
while the Port LEDs cycle through 
the power up sequence. 

The Port LEDs will consecutively 
illuminate RED from Port 1 through 
Port 8 and remain on until all are 
illuminated. 
The Port LEDs all turn off. 
The Port LEDs consecutively 
illuminate GREEN from Port 8 
through Port 1 and remain on until 
all are illuminated. 

The System LED illuminates 
AMBER and remains on for five 
seconds. 

The Port LEDs all illuminate 
AMBER and remain on for 5 
seconds. 
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LED Behavior During  
Power Up Sequence as  

viewed from the  
FRONT 

LED Behavior During 
Power Up Sequence as 

viewed from the  
REAR 

SYSTEM LED PORT LEDs NETWORK LED 
 
The System LED will flash on and 
off GREEN and continue flashing 
while the Port LEDs cycle through 
the port classification sequence. 

The Port LEDs cycle through the 
port classification sequence. Port 1 
illuminates AMBER and remains on. 
Port 2 illuminates AMBER. 
Ports 1 and 2 LEDs turn off. 
Port 3 illuminates AMBER and 
remains on. Port 4 illuminates 
AMBER. 
Ports 3 and 4 LEDs turn off. 
Port 5 illuminates AMBER and 
remains on. Port 6 illuminates 
AMBER. 
Ports 5 and 6 LEDs turn off. 
Port 7 illuminates AMBER and 
remains on. Port 8 illuminates 
AMBER. 
Ports 7 and 8 LEDs turn off. 

The power up sequence is completed. The System LED will continue to 
flash on and off GREEN during normal operating conditions. 
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LED Visual Indicators of Operation 
 

 
 

Figure 12: DPoE™ Compact 8 Midspan (Front and Rear LED Detail) 
 

Table 7: Power Midspan System LED Indications 
 
LED Color System LED Status Description Status of Power Ports 
Off Off No Power is being supplied to the 

power midspan. 
Power is NOT being delivered 
to the ports on the power 
midspan. 

Green Flashing System operating normally. Power is being delivered to the 
ports on the power midspan, 
as configured. 

Amber Flashing Out of voltage range condition.  
Less than 36VDC or more than 
57VDC is being supplied to the 
power midspan.   

Power may not be delivered to 
any ports on the power 
midspan because the voltage 
is out of specification. 

Red ON continuous The DPoE™ Compact 8 Midspan 
management processor is operating 
properly but the PSE capability has 
failed. 

Power may not be delivered to 
any ports on the power 
midspan. An SNMP trap will 
be issued with information 
about this condition. 

Red Rapid Flashing 
Slow Flashing 
Solid 

The DPoE™ Compact 8 Midspan 
management processor firmware is 
being updated. 

Power continues to be 
delivered to any IEEE 802.3af 
configured ports while a 
firmware installation is 
occurring. 

Amber Flashing DHCP acquisition in progress.   Power is being delivered to the 
ports on the power midspan, 
as configured. 
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Table 8: Port LED Indications 
LED Color Port LED Status Description Status of Power Ports 
Off Off No Powered Device (PD) is attached to this 

particular port on the power midspan. Or the 
attached PD was not identified as a 
compatible PD for PoE. 

Power is NOT being 
delivered to this port on 
the power midspan. 

Amber Solid The power midspan is determining the PD's 
power requirements.  This occurs for 5 
seconds after the PD is connected. 

Power is NOT being 
delivered to this port on 
the power midspan. 

Green Solid Port operating normally. Power is being delivered 
to this port on the power 
midspan. 

Red  Solid The system has failed to determine the PD 
power requirements for this port.  Perhaps 
this PD is not an 802.3af-2003 compliant or 
Cisco legacy power device.  
 
This may also be an indication of a short in 
the wiring.  The connections at both ends of 
the horizontal cabling should be checked to 
ensure proper wiring has been followed. 
 
A connected non-powered device such as a 
PC may be terminated in such a way that 
the DPoE™ Compact 8 Midspan attempts 
to detect it as a PD. The Element Manager 
may be used to turn detection off to this port 
so no further checks occur. (see PoE 
power mode) The LED will turn off. 

Power is NOT being 
delivered to this port on 
the power midspan. 

Table 9: Network Status LED Indications 
LED Color Network LED Status Description Notes 
Off Off No connection to the management 

system.   
If the system is 
otherwise operating 
normally and an 
Ethernet cable is 
connected, this could be 
an issue with the panel's 
management interface.  

Green Flashing The management link on the DPoE™ 
Compact 8 Midspan is configured 
correctly and communication messages 
are currently being processed. 

Normal operation. 

Green Solid The management link on the DPoE™ 
Compact 8 Midspan is configured 
correctly, but no communication 
messages are currently being processed 
(i.e., link idle). 

Normal operation. 

Amber Solid The panel is currently trying to acquire 
DHCP address information from the 
network. 

If this persists for more 
than a minute or two, 
there is a problem with 
the network 
communication. 
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PANDUIT® DPoE™ ELEMENT MANAGER  
 
The DPoE™ Element Manager software is used to remotely control, configure and monitor a DPoE™ 
Compact 8 Midspan within a network. Once installed on a shared or dedicated Windows-based Personal 
Computer (PC), the DPoE™ Element Manager can be used to manage an entire network of DPoE™ 
devices. The DPoE™ Element Manager is on a CD-ROM included with the DPoE™ Compact 8 Midspan.  
 
NOTE: The DPoE™ Compact 8 Midspan does not require the DPoE™ Element Manager for the 

power midspan to operate. An installed DPoE™ Compact 8 Midspan will source PoE 
power without the DPoE™ Element Manager. The DPoE™ Element Manager provides 
an optional enhanced level of remote management, monitoring and maintenance for a 
single device or an entire network of PoE devices. 

 
Hardware and Software Requirements 
 

Table 10: PC Minimum Requirements for DPoE™ Element Manager 
 
Hardware Processor PC with 300 megahertz (MHz) Pentium®-class 

processor or equivalent 
 RAM 128 MB of RAM, 256 MB recommended 
 Hard Disk Space 45 MB of hard disk space 
 Network Access 10/100 Ethernet card 
 CD-ROM Drive  
Software Operating System  Any of the following:   

Windows® Vista™                                      
Windows® XP Professional (Service Pack 1 or later), 
Windows XP Home Edition (Service Pack 1 or later), 
Windows 2000 (Service Pack 4 for Windows 2000). 

 Support Applications 1. Microsoft .NET Framework 1.1 Redistributable or 
later (See notes below) 

2. Microsoft Data Access Component version 2.7 or 
later (See notes below) 

 Display Settings For XP Professional or Home Edition: 
Settings: 1024x768 or larger                          
Color Quality: Medium (16-bit) or higher 
Advanced: Normal Size Fonts (96dpi) 
REQUIRED                                          
Appearance: Font Size Normal REQUIRED 

For Windows 2000: 1024x768x32K colors 
Small Fonts REQUIRED (Normal 96dpi) 

 
NOTE: If Microsoft .NET Framework version 1.1 or Microsoft Data Access Components is not 

currently installed on the PC, the user will be prompted to install these software 
packages first before installing the DPoE™ Element Manager. The DPoE™ Element 
Manager will not operate correctly without these two support applications being installed 
on the same PC. 

 
NOTE: As of this publication, Microsoft .NET Framework cannot be installed on 64-bit computers. 

 
NOTE: Critical updates to the support programs may occasionally come from Microsoft 

Corporation.  The Windows Update option from the PC’s START Menu can be used to 
periodically check for such updates. 
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Installing the PANDUIT® DPoE™ Element Manager Software 
The DPoE™ Element Manager is installed by running the setup program on the DPoE™ Compact 8 
Midspan Support Tools CD-ROM, included with the DPoE™ Compact 8 Midspan.  Once the CD-ROM is 
placed in the personal computer's CD-ROM drive, the setup program will automatically run and will give 
the user the choice to install the DPoE™ Element Manager software or choose from other selections.  
When selected, the installation software will first verify the necessary support software is available on the 
computer or will prompt the user to determine whether these packages should be installed along with the 
DPoE™ Element Manager. (See  
Table 10: PC Minimum , for more information.) 
 

Requirements

NOTE: If the CD does not autorun, browse the root directory of the CD and double-click on 
the file “Launch.exe”. 

 
Once all required support software is installed, the DPoE™ Element Manager installation screen will be 
displayed (see below). 
 

 
 
For security purposes, the network operator will then be given the opportunity to restrict the DPoE™ 
Element Manager to the administrator UserName only (default) or whether other users of this PC can 
access it.  Once this selection is made, the installation process completes in only a few minutes. 
 

 
 
After the DPoE™ Element Manager installation completes, exit the DPoE™ Power Patch Panel Support 
Tools CD, remove the CD-ROM from the CD-ROM drive, and store it in a safe place. Next, launch the 
DPoE™ Element Manager application via the icon on the desktop. 
 
The splash screen will appear. When prompted, UserName: administrator, Password: Panduit (password 
is case sensitive and should be changed from this default) 
 
NOTE: The DPoE™ Support Tools CD-ROM also includes the option to uninstall the DPoE™ 

Element Manager.   
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Connecting the DPoE™ Element Manager Host Computer to the 
DPoE™ Compact 8 Midspan  
 
The computer that hosts the DPoE™ Element Manager can either be directly connected to the DPoE™ 
Compact 8 Midspan or connected through the Ethernet network. Logically connect the DPoE™ Compact 
8 Midspan, to the PC.  
 
Network Connection  
 

 
Figure 13: DPoE™ Compact 8 Midspan (Rear View) 

 
The DPoE™ Compact 8 Midspan can be remotely managed using the included DPoE™ Element 
Manager. Using a standard patch cord (for example, part number UTPSP3 or UTPCH3), connect the 
management port on the back of the device to an Ethernet switch or directly to a computer that supports 
network communication to the DPoE™ Element Manager. 
 
IMPORTANT: Directly connecting to a PC will likely require first changing the DPoE™ Compact 

8 Midspan from the factory setting of DHCP addressing. 

 
DPoE™ Element Manager Operation 
Once the DPoE™ Element Manager is successfully installed, access the program using the shortcut 
installed on the desktop by the DPoE™ Element Manager installation. (The program is stored in the 
PANDUIT directory under the programs directory and can also be accessed through the START menu.)   
 
After displaying the version number of the DPoE™ Element Manager, the user is prompted for a 
UserName and Password.  
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NOTE: When the management system is first installed, the default UserName is administrator 
 
The default Password is Panduit (notice the capital “P”. Passwords are case-sensitive.) 
 
This default UserName and Password should be changed once the user is familiar with 
the DPoE™ Element Manager software. (See Additions or Changes to 
UserName/Password, for more information.) 

 

 
 

Graphical User Interface 
The DPoE™ Element Manager has an easy-to-use graphical user interface with pull-down menus and 
tool bars, which make configuring and provisioning the network easy. When the DPoE™ Element 
Manager is opened, the following system-level opening screen appears.  
 

 
 

Figure 14: System-Level Opening Screen 
 
The system-level opening screen is broken into three areas: the Tree View of the Network Area, the List 
View of the DPoE™ Compact 8 Midspans and the Message Log area.  By working in each of these three 
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areas, the network operator can easily monitor the overall status of the DPoE™ Compact 8 Midspan 
network, the status of individual DPoE™ devices, or the status of individual ports on individual DPoE™ 
devices.  Likewise, configuration changes can be made at the network, DPoE™ device, or port level. 
 
The Tree View of the Network area provides a hierarchical display of each DPOE device within the 
network using the configurable names assigned by the network operator. Multiple DPoE™ devices 
physically wired into a single rack are grouped on the screen under the configurable name of that rack.  
Using the computer mouse, the operator can select a specific rack, and the display will expand to show 
the individuals DPoE™ devices within that rack. 
   
When the operator selects an individual rack, the DPoE™ Element Manager automatically displays the 
information for each DPoE™ device within that rack in the List View area (top).  Likewise, all log 
messages relating to that rack are automatically displayed in the Message Log area (bottom).  These 
messages indicate any conditions with the rack itself, the DPoE™ devices on that rack or individual ports 
on individual DPoE™ devices. 
 
If the operator selects an individual device from the Tree View of the Network Area, a second screen, 
which overlays the Message Log and List View areas, allows the operator to configure and monitor a 
specific DPoE™ device. (See Figure 15: View Device Screen, for more information.) 
 
In addition to the three areas on the system-level opening screen, the DPoE™ Element Manager 
provides the following conveniences on this system-level opening screen. 
 

• Tool Bars – The most frequently performed actions are assigned buttons on the tool bars to assist 
with assigning ports and DPoE™ devices, adding users to the management system, filtering 
incoming messages for trouble isolation etc. 

• Pull-Down Menus – All functions available through the tool bars are also available through the 
pull-down menus. In addition, network-wide functions, such as copying DPoE™ device 
information from an existing DPoE™ device to a new DPoE™ device is also available. 

• Online Indicator – This real-time display indicates the communication status between the DPoE™ 
Element Manager software and the DPoE™ devices. 

 
The following sections discuss the actions to perform various common tasks within the DPoE™ Element 
Manager. 
 
Additions or Changes to UserName/Password  
By adding additional UserNames to the DPoE™ Element Manager, the network operator can allow 
access to the system by other users without the need for sharing a single UserName/Password among 
multiple users. 
 
The Users option under the Tools pull-down menu provides an easy mechanism to add new or modify 
UserNames.  There is also a button ( ) on the top tool bar on the system-level opening screen to 
perform this task.   
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By clicking on the Add button, the network operator can create new UserNames and Passwords for use 
the system.  A free-form Description field is also available.   
 
Maintenance of UserNames is done by first clicking an existing Username, then clicking on either the 
Remove button to delete that UserName or the Properties button to have the following screen appear. 
 

 
 

After any changes are made, use the Close button to return to the system-level opening screen. 
 
NOTE: Passwords are case-sensitive.  Users must enter the password exactly as the 

network operator assigned it. 
 
NOTE: A user cannot delete a currently active UserName. 
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DPoE™ Device Discovery 
Once the DPoE™ Element Manager is connected into the network, the “Discover” capability can be used 
to "find" the deployed DPoE™ Compact 8 Midspans. The DPoE™ Element Manager initiates messages 
into the control network and requests responses from any DPoE™ devices that see this message.   
 
NOTE: Unless the DPoE™ Compact 8 Midspan has been configured during installation 

using the DPoE™ Element Manager, this Discover capability will only receive the 
configuration and existence of the DPoE™ Compact 8 Midspans themselves.  
The network operator will still need to enter rack and port information, such as 
rack location and where within each rack the DPOE device is physically mounted.  
 
 (The DPoE™ Compact 8 Midspan Installation Worksheet included with the 
product can be used to collect this information during installation.)  
 
When installing multiple DPoE™ devices simultaneously, it is very important to 
record the MAC address for each DPoE™ device.  Since multiple DPoE™ 
devices will return the same factory default settings to the Discover capability, the 
MAC address, which is written on a label on the back of each DPoE™ Compact 8 
Midspan, is unique and will allow the network operator to distinguish one DPoE™ 
device from another.  

 
The Discover option under the Devices pull-down menu will perform this task or click the button ( ) on 
the top tool bar of the system-level opening screen.  
 

 
 

 
The network operator can set the Discover capability to search a specific subnetwork for devices or 
search across a range of IP addresses. If appropriate you should take into account the VLAN IP address 
of the switch port when discovering the panel/power midspan. The two leftmost buttons on this Discover 
Devices window are used to select which type of Discover search to initiate. By selecting the top button, 
the top half of the screen is then used to request a subnetwork search.  
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Subnetwork Search 
After selecting a subnetwork option, the Add, Edit, and Remove buttons become active and give the 
network operator a chance to enter or modify the subnetwork information in the DPoE™ Element 
Manager prior to starting the subnetwork search. When  Add   is selected the Subnet dialog box will open. 

 

 
 
The network operator can then add the desired Subnet, Netmask, SNMP version, SNMP write community 
along with the Administrative Username and Password. Once the desired information is entered the 
network operator can select OK or Cancel. 
 

 
 

 
IMPORTANT: The SNMP Community fields are case-sensitive and allow SNMP messages to be 

exchanged between the DPoE™ Element Manager and the DPoE™ Compact 8 
Midspans.  
 
For security reasons, these fields should be changed from their defaults. However, 
caution should be taken to remember these settings as there are no provisions for 
recalling them once set. 
 
In addition, the default SNMP Version used for communication with the DPoE™ 
Compact 8 Midspan is SNMP v2c. If you change this to SNMP v3, you will need to 
change the “SNMP Version” setting for the subnet discovery to be successful. 
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Once any subnetwork changes are entered (if required), check (  ) and those subnetworks will be 
searched when the Start button is selected.  

 

 
 
When  Start   is selected the Scanning in progress dialog box will open showing the Subnet that is being 
scanned. 
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IP Range Search 
By selecting the bottom button on the Discover Devices screen, the bottom half of the screen is then used 
to request an IP range search as part of the Discover Capability.  
 

 
 
After entering the Starting IP Address, Ending IP Address, and SNMP Write Community, the Start button 
will initiate the Discover capability. 
 
 
When Start   is selected the Scanning selected range dialog box will open. 

 

 
 
 

Whether a subnetwork search or an IP range search was conducted, all discovered DPoE™ Compact 8 
Midspan device information will be populated in the DPoE™ Element Manager. 

 
TIP: In addition to the Discover capability, the DPoE™ Element Manager also supports a 

Refresh capability, which collects the information stored in each device and verifies it’s 
consistent with the information in the DPoE™ Element Manager.  (See   
Refresh the Network, for more information.) 
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Provisioning the DPoE™ device 
The DPoE™ Element Manager has the capability to discover all of the DPoE™ devices in the network 
and display them in a format where the devices are grouped by their host racks based on the information 
entered into the DPoE™ Element Manager during the provisioning process. These are called the Device 
Attributes. 
 
Individually identifying each device and entering its specific attributes into the DPoE™ Element Manager 
is an integral part of the provisioning activity. Loading this information into the DPoE™ Element Manager 
enables it, as well as Network Management Software to be used in an effective working manner. It is 
highly recommended that the Network Administrator invest the effort to provision the DPoE™ device in 
the following manner: 
 
1. During the installation of each DPoE™ Compact 8 Midspan, it is important to record the MAC address 

of the DPoE™ Compact 8 Midspan. This is required because it is the only unique identification of the 
DPoE™ device once it is placed into your network. An installation worksheet is provided to record this 
and other important information. A bar code of the MAC is also provided that allows a bar code reader 
to record this information automatically. The MAC and bar code for the MAC are found on the rear of 
the DPoE™ Compact 8 Midspan near the management port.  

 
2. Once the DPoE™ Compact 8 Midspan is connected to the network and power is applied, the DPoE™ 

device will need to obtain an IP address. 
 

a. The DPoE™ device can obtain an IP address via Dynamic Host Configuration Protocol 
(DHCP). This could take 1-2 minutes depending on your network and DHCP server settings. 

 
b. Or the DPoE™ device can be set to a static IP address. In order to set the device to a static 

IP address, you will need the following information: 
1. The desired static IP Address for the device. 
2. The desired Subnet Mask for the device. 
3. The IP address of the desired Gateway for the device. 
 
 

When you have this information, use the DPoE™ Element Manager to access the device that you 
want to change and select “Edit Panel Info…”  
 
In the “Device IP Address” area highlighted below, select “Static” and then enter the desired IP 
Address, Subnet Mask, and Gateway.  

 

 
 
Once this information is entered, select “Save” and the new settings will be saved to the device and 
the device will respond to those new settings: 
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NOTE: If the computer running the DPoE™ Element Manager is not in the subnet for the new 

IP address and cannot communicate with it, you will receive a timeout message 
similar to the one below: 
 

 
 

In order to correct this you will need to place the computer in the appropriate subnet, 
or correct the network settings of device to the proper setting. If you can no longer 
communicate with the device, see the section on Device IP Address for instructions 
on how to set the device to the default network settings.  (Refer to Panel IP Address 
for more information.) 
 
Occasionally, when retrieving information for the panel/power midspan, the DPoE™ 
Element Manager may show a message indicating an “SNMP Agent Error”. If this 
occurs, retry the operation. If this repeats, it may be the indication of a slow network 
or a large number of concurrent operations, in which case you may have to increase 
the timeout setting of the DPoE™ Element Manager (located under the “Tools” 
section of the application). If the panel/power midspan continues to fail to respond, 
there may be a problem with the network connection itself. 
 
The DPoE™ Element Manager reflects physical location information and power 
status based on the last time this information was refreshed. In order to work with the 
latest physical location information and power status, you should refresh the 
panel/power midspan information using the Refresh icon on the Element Manager 
before making any modifications. 
 
When the IP address of the panel/power midspan is first assigned or is changed, you 
may see the message “The IP address has changed. Do you want to commit this 
(yes/no)?” when you are discovering the panel(s)/power midspan(s) in your network. 
Please select “yes”. Once this change is committed, you will not see this message 
again. 
 
When using the DPoE™ Element Manager to change the network settings of the 
panel/power midspan, and you go from DHCP to static or static to DHCP, you will 
lose communication with the panel/power midspan until the panel/power midspan is 
placed into a network that supports the new settings or your PC is placed into the new 
subnet. This is expected behavior.  

 
3. Using the Discover capability of the DPoE™ Element Manager, search the subnet where the DPoE™ 

devices have been installed. 
4. When the DPoE™ devices are discovered they will appear in a table as shown below: 
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5. The table contains the MAC and IP address of the all of the discovered DPoE™ devices. The 

message log will include the MAC and IP address of the newly discovered device(s). The MAC 
Address can now be used to associate the discovered device with the information contained on the 
installation worksheet, and the Device / Panel Attributes can now be entered. 

6. Double-click on the row in the table containing the first newly discovered DPoE™ device. After the 
DPoE™ device information is gathered from the DPoE™ device, the View DPoE™ device Screen will 
open and will look like this:  

 

 
 

7. Select the Edit DPoE™ device Info and the following form will open. This is where the DPoE™ device 
Attributes can be entered. 
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The DPoE™ device name, rack name, rack space 
position, and contact name should be entered here like 
the example above. The DPoE™ Element Manager will 
create a rack with that name, and any device that has 
the same rack name will be grouped under that rack. 
This screen also includes a place to record the name 
and location information of the power system for this 
DPoE™ Compact 8 Midspan. 

 
Note that the Physical Location entry line allows 1024 
characters of information to be entered, which includes 
additional physical and geographic information for this 
DPoE™ device. This should also be filled out per the 
example below: 
 
Click the OK button and the Device Physical Location information will be added to the device 
attributes field.  

 
8. Once all of the desired information is entered into the device attributes field, click the Save button and 

this information will be saved.  The device and the rack images will be shown in the DPoE™ Element 
Manager Tree View of the Network Area associated with the designated name.  

 
9. Other newly discovered devices can be easily provisioned by copying the Device Attributes from this 

device, and making changes where needed for the new rack names, rack positions, device name, 
etc. This can be done by selecting the table row with the last provisioned DPoE™ device, right 
clicking, and choosing “Copy Device”. Select the next device to be provisioned by highlighting the row 
of the device, right clicking, and choosing “Paste Device." All of the Device Attributes will be applied 
to the new device. Select “Edit Device” and edit Device Attributes and make the appropriate 
modifications. 
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10. The previous step should be repeated for each device in the network until all the devices have been 

provisioned. Once this is done, the DPoE™ Element Manager can easily manage all of the powered 
devices using the more intuitive physical location information that is stored in each device. 
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Administering Port and Device-level Information 
The DPoE™ Element Manager makes it easy to administer the deployed network of DPoE™ devices. 
When a specific device is selected in the Tree Level View of the Network on the system-level screen, the 
DPoE™ Element Manager automatically retrieves the latest power and LED information from the selected 
device and displays on the View Device Screen. (See  
Table 7: Power Midspan System LED , Indications Table 8: Port LED Indications and Table 9: 
Network Status LED Indications for information on the LED Indicators) 
 

 
 

Figure 15: View Device Screen – DPoE™ Device Information 
 
The top portion of the device-level opening window provides a view of the DPoE™ device which in this 
example is the DPoE™ Compact 8 Midspan, complete with the current LED status, IP address, rack 
name and rack location. The information on this screen can be edited by selecting the Edit Panel Info…  
button on the right side tool bar. 
 

 
 

Figure 16: View Device Screen – SNMP Settings 
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The second tab on this screen allows user to view the SNMP information currently set for this device.  
This screen cannot be used to modify the configuration SNMP information. The SNMP configuration can 
be edited selecting the Edit Panel Info…  button on the right side tool bar. 
 

 
 

Figure 17: View Device Screen – High Power Information 
 
The third tab on this screen allows one to view the port power consumption for this device.  A Refresh 
button is provided to obtain the latest per port power consumption levels.  This tab also displays the 
whether the High Power setting is ON or OFF. Clicking the Edit button within the High Power Settings 
section can change this setting. Clicking the Save button within the High Power Settings section will save 
the High Power setting to the mode selected either OFF or Manual. The Manual High power setting 
allows the user to manually set the appropriate power level beyond 15.4 Watts per port up to 30 Watts 
per port based upon the powered devices powering capability and the source power supply headroom. 
 

 
 

Once the High Power setting is enabled to Manual setting the Port Information can be edited for High 
Power levels. PoE Power Mode can be set to Forced with Check or Forced and the Maximum Port Power 
can be selected for the Powered Device (see PoE Power Mode for more information on Forced with 
check or Forced power modes). 
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The following Warning message will be issued when the Manual High power setting is enabled and the 
Port Information PoE Power Mode is set as Forced with check or Forced. 
 

 
 

Edit Panel Information 
 

In addition to the Edit Panel Info button on the tool bar, the Edit Panel option under the Devices pull-down 
menu provides an easy mechanism to perform this task.   
  

 
 

Figure 18: Edit Panel Screen 
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TIP: Prior to modifying any entries on this screen, click on the Refresh button to retrieve the 
latest information stored in the specific DPoE™ device. 

 
This screen will allow the network operator to change the device IP address, the device attributes, the 
SNMP setting, or the trap settings.  
 
After any changes are made, clicking the Save button will store the information and transmit it to the 
DPoE™ device. 
 
Active Port Indicator 
 
By clicking on any device port, its status information will be displayed and the selected port will be 
highlighted with a yellow flashing indicator on the EMS screen. 
 
When the select device is displayed you can click on a port (for this example port 5) and the selected port 
will highlight with a flashing yellow indicator. You will receive a dialog box on screen stating that the EMS 
is obtaining the latest information for the selected port. 
 

 
 
The port information will be displayed (for this example port 5) and the selected port will continue to be 
highlighted with the flashing yellow indication.  
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Figure 3: Active Port Indicator Screen 
 
The Port information and yellow indicator will remain until another port is selected or you navigate to 
another screen view in the EMS. 
 
Device IP Address 
 
The DPoE™ Compact 8 Midspan device comes with a factory setting of DHCP address assignment. After 
the device is connected to the DPoE™ Element Manager, the network administrator may change this 
setting by adding an IP address & Subnet Mask, if desired, to be consistent with the rest of his/her 
network. The Gateway field is the IP address of a gateway.  If the DPoE™ Element Manager and the 
DPoE™ devices are on different networks or if the Simple Mail Transfer Protocol (SMTP) server is on a 
different network from the device, the device will send those messages to the gateway IP address 
specified. 

 
NOTE: The DPoE™ Compact 8 Midspan supports either static IP addressing or DHCP address 

selection.  If the device is set for DHCP, no other information is required in this section.   

 

This portion of the screen can be used to set the 

Device Attributes 
 

Device Name, Rack Name, Rack 
Space Position, Device Physical Location, and Power Supply Location.  These fields 
are freeform and, while these fields will not change the operation of the DPoE™ 
Element Manager, they allow the DPoE™ Element Manager to present the device 
and rack information in a user-friendly format.  For example, with these fields set, 
devices in the same rack will be grouped together in the Tree View of the Network 
area on the system-level opening screen.  Likewise, devices wired in a single rack 
will be displayed consistent with the value in the Rack Space Position   field. (See

Provisioning the DPoE™ device, for more information.)  Once these values are set in the DPoE™ 
Element Manager, this information will be transmitted and stored in the DPoE™ devices. 
   
Two additional fields are available on this screen, which affect the operation of the DPoE™ device.  The 
first field, the Power Threshold, allows the network operator to configure the available power for this 
DPoE™ device as a percentage of the maximum power the device can support. For example, the 
DPoE™ Compact 8 Midspan can support 240 watts (8 x 30 Watts per port). If the power supply 
supporting the DPoE™ Compact 8 Midspan supplies less than 240 Watts the Power Threshold setting 
can be configured to send an alarm message when the power being demanded by the DPoE™ device 
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approaches the maximum available power. Therefore, the Power Threshold for this device could be set at 
50%.  The Power Warning Threshold, which prompts the device when to send an alarm messages, could 
be set at 10%, so that the device initiates the alarm message when it reaches 90% of this particular 
device's maximum power. (See 
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DPoE™ Element Manager Log Messages, for more information on Power Warning Threshold.)  
 
The Enable Trap is a checkbox (  ) that allows the user to turn on or off an individual DPoE™ device’s 
reporting of threshold power alarms. 

 

 

 



PANDUIT® DPoE™ Compact 8 Midspan  Part Number: PN424E  

  
  44  

SNMP Settings 
 
The system defaults to “public” for the SNMP Read Community and “private” for the SNMP Write 
Community.   
The SNMP Version Support can be selected to include v1/v2c/v3 or v1/v2c or v3 
 

 
 

 
There is an SNMPv3 button within the SNMP settings section. Selecting this button will bring up the 
following dialog box. 
 

 
 
This dialog box allows the user to enter the Administrative Username, Authentication Password and 
(optionally) the Encryption Password in support of SNMPv3. 

 
IMPORTANT: The SNMP Community fields are case-sensitive and allow SNMP messages to be 

exchanged between the DPoE™ Element Manager and the DPoE™ devices.  
  
FOR SECURITY REASONS, THESE FIELDS SHOULD BE CHANGED FROM 
THEIR DEFAULTS. 

 
SNMP Access and Security 
The security for the agent is based on a modified version of the security methods provided by the IETF.  
A set of users is provided with varying capabilities.  The administrator account is able to change 
passwords and Authentication Levels (noAuthNoPriv, authNoPriv, authPriv).  The following lists 
capabilities for each user. 

 
NOTE: It is recommended that the user change these passwords and community strings 

during provisioning. 
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Table 11: SNMPv3 Defaults and Access 
 

User Default 
Password 

SNMP 
Version 

Minimum 
Authlevel 

Read Write 

Administrator setup_passphrase v3 authNoPriv All All 
Maintenance setup_passphrase v3 authNoPriv All All except: usmUserTable 

panduitNetSNMPACMTable 
Read Only setup_passphrase v3 noAuthNoPriv All 

- Can not read 
writecommunity 

Nothing 
 

Discovery setup_passphrase v3 noAuthNoPriv SystemGroup 
of RFC 3418 

Nothing 
 

Private N/A v1/v2c N/A All All except: usmUserTable 
panduitNetSNMPACMTable 

Public N/A v1/v2c N/A All 
- Can not read 
writecommunity 

none 

 
Trap Settings 
 
The Trap Setting section allows the network operator to configure the DPoE™ Compact 8 Midspan to 
send configuration and alarm messages to up to five different IP addresses. 

 
IMPORTANT: One of the Traps must be configured and set to the IP address of the DPoE™ Element 

Manager in order for the DPoE™ Element Manager to receive configuration and alarm 
messages from the DPoE™ device. 
 
The computer running the DPoE™ Element Manager should not have any other programs 
running that receive trap information. 

 
 

 
 

The IP Address, SNMP Community String and SNMP version are set according to the destination device 
for these outgoing messages.  The Enable check box provides an easy on/off button for the traps without 
having to delete the entered information. 
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Note that when the SNMP version is set to v3 the SNMP Community String field changes to blank and 
allow entry of the SNMPv3 Username. Also when the SNMP version is set to v3 the security level (v3 
SecLev) can be selected either “1” No Authentication No Privacy encryption,  “2” Authentication No 
Privacy encryption, and “3” Authentication and Privacy encryption. 
 
The other fields, Critical, Major, Minor, Advisory, refer to the priority of the messages and allow the 
network operator to designate which message should be sent for each trap.  (See page 50, 
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DPoE™ Element Manager Log Messages, for more information.) 
 
Edit/Copy/Paste/Delete Device Information 
 
The DPoE™ Element Manager also provides a unique feature that will allows the network operator to 
more efficiently configure the network by allowing all device-level information to be copied from one 
device to another. The Copy Device and Paste Device options under the Devices pull-down menu provide 
an easy method to perform this task.   
 
Once a device is highlighted in the Tree View of the Network Area on the system-level opening screen, 
the View Panel Screen for that DPoE™ device will appear.  Using the Copy Device function all the 
device-level information will be copied into a buffer.  Selecting another similar device on the Tree View of 
the Network and then selecting the Paste Device option will paste the device-level information (Device 
Attributes, SNMP Settings and Trap Settings) from the copied device into the selected one (destination).  
The paste device capability can continue by selecting another device and then selecting the Paste Device 
option again. 

 
NOTE: The Paste Device option does not overwrite the IP Addressing information for the device.  

(See page 34, Edit Panel Information, for more information.) 

 
The Delete Device option under the Devices pull-down menu provides a simple way to delete a DPoE™ 
device from the DPoE™ Element Manager. This capability may be required if devices are being removed 
from the network. Once a device is highlighted in the Tree View of the Network area on the system-level 
opening screen, the View Panel Screen for that DPoE™ device will appear.  Selecting the Delete Device 
function will erase all device-level information in the DPoE™ Element Manager for this device. 

 
NOTE: Since the master copy of all device information in stored in the device itself, the Discover 

function has the capability to find the device in the network and restore the information if it 
was erroneously deleted. 
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Backup of Panel and Port Information 
 
Once a DPOE™ device has been discovered, information from that device can be exported using the 
Export Device Information in the Tools menu bar. This may be necessary if the DPOE™ information 
needs to be backed-up in the event of a complete firmware update, to keep records of established 
information, or as a means to copy information from established units into new units prior to configuration. 
 

 
 
A dialog box will appear allowing device information to be exported for All Devices, Devices that are in the 
Selected Rack / Room, or for the Selected Device. The Refresh Data box prompts the system to obtain 
the most recent information from the device. 
 
After hitting OK, a dialog box will appear requiring a file name and desired location to save the file. The 
first data file will be the panel summary information (network, physical allocation, etc.) 
 

 
 
Another dialog box will prompt a confirmation to export all associated port information as well (work area 
location, etc.).   NOTE: these are two independent files with unique information. 
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Once confirmed, another dialog box will appear and require a file name (such as “Panel A Ports”) and a 
desired location to save the file. 
 

 
 
Once the Device and the Port information are saved, factory resets, firmware downloads, or other 
reconfigurations may be performed, with the ability to restore the previous device and port configuration 
information. NOTE: When a complete firmware update is performed, the device/port database in memory 
is erased.  
 
Restoring Device and Port Information 
 
The Import function allows retrieval of saved device and port data (that has been previously extracted and 
saved to a file using the Export function). 
 
Once a device has been discovered and identified in the DPoE™ Element Manager, retrieved device 
information may be imported into a discovered device using the Import Device Information function in 
the Tools menu bar. The device to receive the retrieved information is chosen by double-clicking on that 
device’s row from a list of all discovered devices.  NOTE:  the Import Device Information menu option will 
not appear if a device has not been discovered or selected. 
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A pop-up window will ask for confirmation to import the device information. 
 

 
 
A pop-up window will also ask for confirmation to import the port information. 
 

 
 
After confirmation, the Import Port screen will appear, requiring the previously saved panel port 
information (from the Export exercise) to be located and opened. 
 

 
 
After opened, there will be a delay as the panel information is written into the selected panel. 
 
CAUTION:  No error checking is performed in a DPOE™ device. If a device is selected incorrectly, it is 
possible to overwrite a 24-port configuration information into an 8-port device (only the data representing 
the first 8 ports will be used). Conversely, and 8-port device can overwrite information into a 24-port unit. 
This may be desirable for device level configuration information (e.g., owner, location, etc), but may be 
undesirable for port information. 
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View Port Information 
 
In addition to the View Port Info button on the tool bar, which will display configuration information for all 
ports on the specified DPoE™ device, the operator may double-click any port on the Visual Display of the 
Front Panel portion on the View Panel Screen to view the information for that port only.  
 
Clicking the View Port Info button will display the following screen and allow the network operator to 
administer the ports on a given DPoE™ Compact 8 Midspan. 
 

 
 

Figure 19: View All Ports Screen 
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Edit Port Information 
 
Clicking any row on the port information section of this screen will bring up the configuration information 
for that individual port.  This is the same screen that will appear by double-clicking an individual port on 
the Visual Display of the Front Panel portion on the View Panel Screen. 
 
TIP: By holding down the <ctrl> key, the network operator can select multiple ports within the 

same DPoE™ Compact 8 Midspan. Then, by selecting the Edit button on the Tool Bar, 
the user can configure multiple ports simultaneously.  Any fields not specifically 
overwritten with new values will be left unchanged.   

 

 
Figure 20: View Individual Port Screen 

 
Clicking on the Edit button will bring up the screen to edit an individual port on the DPoE™ device.  
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If a multiple port edit was being configured the following screen would appear and any values that were 
not overwritten would be left unchanged.  

 

 
 

Administration Control - This setting {on/off} allows the network operator to control whether each 
individual port is sourcing PoE power.  If this field is set to off, the port behaves like a non-powered port 
rather than a PoE port. This enables the network operator to mix non-powered or locally powered devices 
in the same DPoE™ Compact 8 Midspan. The factory default setting for this field is ON. 

 
Power Priority - These settings {low, high, critical} indicate the priority level of maintaining PoE power to 
this port in low-power situations.  This field is used in conjunction with Network Management Systems (if 
deployed). 
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PD Type - This free-form field allows the network operator to enter information on the Powered Device 
(PD), such as the type of device (IP-phone, camera, etc.). 
 
PoE Power Mode - These settings {Normal, Forced with check, Forced} indicate the power mode being 
delivered to a powered device. In “Normal” mode the device port will deliver the standard IEEE 802.3af-
2003 compliant powering or the Cisco-In Line powering scheme. In the “Forced with check” mode the 
device port will deliver power only when a non-open circuit is detected. The port checks for a closed 
circuit condition and will not apply power until a load is detected across the circuit. In “Forced” mode the 
device port will deliver power without performing a detection classification. If nothing is detected within the 
circuit then “no device connected” traps will continuously be generated until a load is connected. 

 
WARNING: Forced power mode is not a normal operating condition. Although Forced mode abides 

by the PoE under and over current shut down precautions potential damage could be 
caused to certain non-PoE devices that are connected in Forced mode. 

 
Legacy Detection – These settings {enabled, disabled} allow the PoE device detection to be modified.  If 
this setting is enabled, the DPoE™ Compact 8 Midspan will detect both Cisco-In Line powering scheme 
and the IEEE 802.3af-2003 standard powered devices.  If this setting is disabled, the DPoE™ Compact 8 
Midspan will detect only devices that follow the IEEE 802.3af-2003 standard. 
 
Work Area Location - This freeform field allows the network operator to enter information such as the 
location where a device is located.   
 
Export Log 
 
The Export Device information capability is similar to the Export Device capability. This function allows the 
network operator to copy the Log Messages from the currently selected port, DPoE™ Compact 8 
Midspan or the entire network of DPoE™ devices into an external file.   
 
The Export Log button on the tool bar on the View Panel Screen provides an easy mechanism to perform 
this task. 
 

 
 



PANDUIT® DPoE™ Compact 8 Midspan  Part Number: PN424E  

  
  55  

View Entire Log 
 
The View Entire Log button on the tool bar on the View Panel Screen is used to the entire log of 
messages generated about the selected device.  Viewing the message logs can also be activated from 
within the DPoE™ Element Manager using the  button on the top screen tool bar. 

 

 
 

Figure 21: View Message Log Screen 
 
The View Message Log area provides a sequential listing of all messages received by the DPoE™ 
Element Manager, displaying them in a first-in, last-out manner.  That is, the most recently received 
messages are listed at the top of the window and the older messages are pushed down toward the 
bottom of the window.  The “rewind” and “fast-forward” buttons in the right half of the tool bar for the 
Message Log area are used to navigate through the message logs should it grow beyond the viewable 
area. 
 
Filter Log Messages  
By clicking on the Filter Messages button, the operator can selectively view and/or export a subset of the 
log messages.  
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Figure 22: View Message Log Filter Parameter Screen 
 
The Message log can be sorted and viewed generating a filtered message subset using any combination 
of the following parameters: 
 

• Date Range  
• Rack Name or a range of Rack Names 
• Rack Space Location or range of Rack Space Locations 
• IP address or range of IP addresses   
• MAC Address or range of MAC Addresses 
• Device Name or range of Device Names  
• Port Number or range of Port Numbers 
• Specific message type  

 
 
Export Log 
 
By clicking on the Export Log button, the operator is given the option of exporting the log file related to a 
particular device, rack or the entire log to a file. 
 
Clear Log 
 
By clicking on the Clear Log button, the operator will be given the opportunity to export the log before 
erasing the entire log. 
 
NOTE: Clearing the log will clear the entire message log in the DPoE™ Element Manager.  It 

cannot be used to selectively clear a portion of the log.   
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Refresh the Network 
The Refresh option under the Devices pull-down menu or the button ( ) on the top tool bar provides an 
easy method to insure that the configuration and status information in a deployed network of DPoE™ 
devices is consistent with the DPoE™ Element Manager.  Changes in network status or configuration 
changes made by another DPoE™ Element Manager operating within the same network of devices are 
reasons why devices may exhibit different information than displayed on the current DPoE™ Element 
Manager screen. 

 
 
The Refresh capability can allow a Refresh of the entire network, all the devices in a rack, or a single 
device within a rack.   
 
Administering E-mail Settings 
 
By using the E-mail capability, the network operator can assign specific e-mail addresses to be notified of 
network events.  For example, the DPoE™ Element Manager can be configured to send e-mail messages 
to one or more e-mail addresses in the event of configuration changes, incoming alarms or other events 
within the network of DPoE™ devices.  There are 19 categories of messages, alarms and events, which 
can be flexibly assigned to any of the e-mail addresses. 
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The E-Mail Settings option under the Tools pull-down menu provides an easy method to add new e-mail 
addresses to the system and to administer which events trigger messages to e-mail accounts.  There is 
also a button ( ) on the top tool bar on the system-level opening screen that can be used to perform this 
task.   

 
NOTE: Before any e-mail messages can be sent from the system, the SMTP Server and 

Source E-mail Address fields must be entered.  
  
The Source E-mail Address will be used as the "from" address on all e-mails 
sent from the DPoE™ Element Manager Element Manager.  
 
Once this information is added, check the E-mail Enabled box and store the 
settings using the Save button. 

 
By clicking on the Add button, the network operator can enter a destination e-mail address that will 
receive notification e-mails when the selected network events occur.   
 

 
 

Once the e-mail addresses are entered into the system and a specific e-mail address is selected on the 
left panel of the E-mail Settings, the right panel is used to select which message categories will be sent to 
that e-mail address. (See page 50, 
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DPoE™ Element Manager Log Messages, for information on these message types.) 
 

NOTE: The same category of events may be selected for multiple destination e-mail 
addresses. 

 
The Edit button is used to change the e-mail address of an already assigned e-mail address without the 
need to delete and reenter the selection criteria.  
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Search for Specific Devices or Ports 
The Search option under the Tools pull-down menu or the tool bar button  on the top tool bar on the 
system-level opening screen provides an easy method to search the DPoE™ Element Manager for 
specific devices or port.   
 
NOTE: The * character may be used to perform wild-card searches. 

 
The first screen to appear is the Device Search Parameter.  Three alternate TABS at the top of the 
screen can be selected to perform a search for a specific device, port or link. 

 
Figure 23: Device Search Parameter Screen 

 
The Device Level Search can be categorized and the results viewed using any combination of the 
following parameters: 
 

• MAC Address 
• Device Name 
• Rack Name 
• Rack Space Location 
• Hardware Version 
• IP Address 
• Physical Location 
• Power Supply Location 
• Firmware Version 

 

 



PANDUIT® DPoE™ Compact 8 Midspan  Part Number: PN424E  

  
  61  

 
 
 

 
 

Figure 24: Port Search Parameter Screen 
 
The Port Search can be categorized and the results viewed using any combination of the following 
parameters: 

 
• Port Number 
• PD Type 
• Work Area Location 
• Power Mode 
• Administration Control 
• Detection Status 
• Power Priority 
• Power Classification 
• Legacy Control 
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Figure 25: Link Search Parameter Screen 
 
The Link Search can be categorized and the results viewed using any combination of the following 
parameters: 

 
• Link ID 
• Panel Location 
• Allowed MAC Address 
• Connected MAC Address 
• Panel ID 
• Panel Port 
• Denied MAC Address 
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DPoE™ Element Manager Log Messages 
The following types of messages are generated within the DPoE™ device network and are displayed in 
the DPoE™ Element Manager logs. While most of these messages are generated by a DPoE™ device in 
the network, several of these messages originate within the DPoE™ Element Manager when, for 
example, it looses communication with one of the devices in the network. The messages carry four levels 
of priority: Advisory, Minor, Major, and Critical. Several messages are not applicable and are reserved for 
future applications. 

Table 12: DPoE™ Element Manager Log Messages 
 

Message Category Priority 
Level 

Description 

Undiscovered Device – Cold Start Advisory The main software process (i.e., the device 
agent) in a previously unknown device is 
now up and running. 

Device Agent – Cold Start Advisory The main software process (i.e., the device 
agent) in a previously known device is now 
up and running. The process will likely reset 
itself. 

New Device Discovered Advisory The Discover capability has found a new 
device.   

PD Connected Minor A new Powered Device has been detected 
at the panel. 

PD Disconnected Minor A Powered Device has been disconnected. 
PD Fault Major A Powered Device is unable to 

communicate an acknowledgement. 
Device Power Above Threshold Major The power consumption at the device has 

risen above the Power Warning Threshold. 
Device Power Below Threshold Major The power consumption at the device has 

fallen below the Power Warning Threshold. 
Fuse Blown Critical The internal safety fuse has opened due to 

a catastrophic failure of the unit. 
Port Physical Location Changed Advisory Location information of one of the ports has 

changed using the DPoE™ Element 
Manager.  

Device Self-Test Failed Critical The Device self-diagnostic test has failed.  
Device Self-Test Passed Advisory The Device self-diagnostic test has passed.  
Trap Recipient Changed Advisory One of the traps associated with a particular 

device was changed using the DPoE™ 
Element Manager.  

PD Detection Failure Major Device detected failure with one of the 
Powered Devices. 

Device Agent Lost Communication Critical DPoE™ Element Manager cannot 
communicate with the specified device.  

IP Address Changed Advisory The IP address at one of the devices has 
changed using the DPoE™ Element 
Manager. 

Low Device Voltage Major Measured device voltage is below the 
minimum allowable for PoE. 

High Device Voltage Major Measured device voltage is above the 
minimum allowable for PoE. 

Location Information Changed Advisory The DPoE™ device that was previously 
discovered has not been relocated to 
another location in the network. 
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Miscellaneous Settings 
 
Several miscellaneous settings must be configured for the DPoE™ Element Manager to communicate 
properly with a network of DPoE™ devices. 
 
The Settings option under the Tools pull-down menu provides an easy method to administer these 
settings.   
 
 

 
 
If the Online indicator is not checked ( ), the DPoE™ Element Manager assumes it is in the offline mode 
and will not attempt to connect to the deployed DPoE™ device Network.  Changes made within the 
DPoE™ Element Manager will not be updated in the DPoE™ devices. 
 
When the total port power sourced on any given DPoE™ device reaches the Power Warning Threshold 
the DPoE™ device will issue a warning alarm and display that the DPoE™ device has reached or 
exceeded the warning threshold value. The threshold value is set as a percentage below the maximum 
power level.  
 
NOTE: The power-warning threshold above setting is system-wide. It is used as a 

percentage below maximum for each individual device.  Some devices in the 
network might have their maximum device power set at different levels and 
therefore would alarm at different points.  (See page 34, Edit Panel Information, 
for more information on the Power Threshold field.) 

 
Rack Space Numbering is a system-wide field {ascending, descending} that enables the DPoE™ Element 
Manager to display the DPoE™ devices physically in the same fashion as they are wired in the network 
racks.  Either the rack slots are numbered from with the highest rack positions at the top (descending) or 
the highest rack positions at the bottom (ascending). By setting this parameter appropriately, the rack-
level displays presented by the DPoE™ Element Manager will show the DPoE™ devices in their installed 
order. 
 
The SNMP Timeout Value is a configurable threshold.  If the SNMP Timeout Value has elapsed and the 
system has not yet received an acknowledgement from a previously transmitted SNMP message, the 
system will assume there is an SNMP communication problem.  
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Firmware Update of the DPoE™ Compact 8 Midspan  
The DPoE™ Compact 8 Midspan has the ability to have its firmware programmed remotely. A Trivial File 
Transfer Protocol (TFTP) operation can be initiated using the DPoE™ Element Manager. The Firmware 
Update option under the Tools pull-down menu provides a method to perform the update.  
 
 
NOTE: The latest version of firmware may be downloaded after product registration at 

http://www.panduit.com/Support/Software/index.htm. The panduit.com website 
will allow users to download firmware updates to their own TFTP server. 

 
NOTE: An important feature of the DPoE™ Compact 8 Midspan is its ability to continue 

supplying Power over Ethernet during firmware updates.  All IEEE 802.3af and 
Cisco In-Line protocol legacy powered devices connected to the power midspan 
will remain powered during a firmware update. Cisco In-Line protocol legacy new 
powered device detection may experience an interruption during a firmware 
update.  

 
Insure that the DPoE™ device is connected to a Network or PC that has the Element Manager 
application running and has the device to be programmed discovered (see Device Discovery) 
 

 
Figure 27: DPoE™ Compact 8 Midspan (Rear View) 

 
Detailed Description of the Firmware Update 
 

1. Download the new DPoE™ product file from http://www.panduit.com/Support/Software/index.htm 
 
2. Start a local TFTP server. This may require downloading and configuring TFTP server freeware 

or shareware from the internet. 
 

3. The Firmware Update option under the Tools pull-down menu opens a window that identifies the 
IP address, device type and device name. The window as shown in Figure 26 DPoE™ Element 
Manager Firmware Update Screen can then be used to initiate the TFTP firmware update by the 
user entering the firmware filename and IP address of the TFTP server. 

 

http://www.panduit.com/Support/Software/index.htm�
http://www.panduit.com/Support/Software/index.htm�
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Figure 26: DPoE™ Element Manager Firmware Update Screen 
 

4. Enter the TFTP information in the DPoE™ Element Manager screen and then click on the Begin 
Update button. 

 
5. Observe the Network status LED begins flashing red on the DPoE™ Compact 8 Midspan. See 

Table 13  DPoE™ Compact 8 Midspan Firmware Update LED status for the LED activity during 
the Firmware update. 

 
6. Allow sufficient time for the Firmware Update to complete. (Approximately 10 minutes) 

 
7. When the Firmware Update is complete the Network status LED resumes flashing green. 
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Table 13: DPoE™ Compact 8 Midspan Firmware Update LED Status 
 

System LED  
Color and activity 

Network LED  
Color and activity 

State Description Elapsed Time  

 
Red Solid 

 
Off 

Ethernet Switch 
Initialization 

00 – 01 seconds 

Amber Solid  DHCP Initialization  
01 – 100 
seconds 

Green Blink DHCP complete 

Red rapid Blink  
Green Blink 

Image transfer and 
update in progress  

5 - 7 minutes 

Red slow Blink CRC code 4 seconds 
Red Solid Image update  

complete 
END 

Green Slow Blink Application Running  
 
Exiting the DPoE™ Element Manager 
The Exit option under the File pull-down menu or the button ( ) will exit the DPoE™ Element Manager.   
 
Resetting the DPoE™ Compact 8 Midspan  
 
In the event of a lock up condition or a “lost” device the DPoE™ Compact 8 Midspan has the ability to be 
hardware reset. The reset operation is initiated by inserting a rigid rod (straightened paperclip) into the 
RESET hole on the rear of the unit and actuating the reset pushbutton.  There are four levels of reset 
actions that can be enabled. Each of the four reset levels is accomplished by holding in the pushbutton 
reset switch for subsequently longer time durations. A typical requirement for performing a hardware reset 
would be a processor reset, a DHCP reset, an SNMP community reset, or a complete reset to the factory 
default settings. 
 
 

 
Figure 28: DPoE™ Compact 8 Midspan (Rear View) 
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Detailed Description of the Pushbutton Hardware Reset 
 

1. When the reset pushbutton is pressed the system and rear LED will light solid red for 05 seconds. 
If the reset pushbutton button is released during this time nothing will happen. 

 
2. If the reset pushbutton is pressed for an additional 01 to 05 seconds (elapsed time 06 to 10 

seconds) and then released, a processor reset will be performed. LED will flash fast green during 
this interval. 

 
3. If the reset pushbutton is pressed for an additional 01 to 05 seconds (elapsed time 11 to 15 

seconds) and then released, IP configuration will be cleared from memory and the processor will 
be reset. This will force a DHCP initialization. LED will flash fast amber during this interval. 

 
4. If the reset pushbutton is pressed for an additional 01 to 05 seconds (elapsed time 16 to 20 

seconds) and then released, SNMP community data will be cleared from memory and the 
processor will be reset. LED will flash fast red during this interval. 

 
5. If the reset pushbutton is pressed for any additional elapsed time beyond 21 seconds and then 

released, **ALL** memory data will be set to a factory default and the processor will be reset. 
LED will be solid red during this interval. 

 
 

Table 14: DPoE™ Compact 8 Midspan Pushbutton Hardware Reset Sequence 
 

Reset pushbutton released when LED 
Color is: 

 
Result 

Elapsed Time in 
Seconds 

Initial Solid Red No Action 00 - 05 
Flashing Green Processor Reset 06 - 10 
Flashing Amber DHCP Reset 11 - 15 

Flashing Red SNMP Community Reset 16 - 20 
Concluding Solid Red All FLASH data set to factory 

default 
 

21+  
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BASIC TROUBLESHOOTING 
 
Use the Basic Troubleshooting guide to help resolve problems installing the DPoE™ Compact 8 Midspan. 
If a problem persists, contact PANDUIT Customer Service or a local sales representative. 
 

Table 15: Basic Troubleshooting Guide 
 

Problem Possible Causes and Solutions 
The DPoE™ Compact 8 Midspan SYSTEM LED 
does not light when power is applied to the unit.  

1. No power is available at the power midspan or 
the power connection may be bad.  

2. Check the physical connection of the keyed 
power connector. Insure that the DC 
connection is properly mated to the power 
midspan’s power receptacle. 

3. Make sure the power supply is plugged in to a 
working AC source and is operational. 

The DPoE™ Compact 8 Midspan SYSTEM LED 
is flashing green but no power is being applied to 
the connected powered devices (PDs). The port 
status LED where power should be provided is 
off. 

1. The PD is not connected properly to the 
DPoE™ Compact 8 Midspan. Make sure that 
the cable to the PD is properly seated and that 
it is connected to the top port, which has data 
and power. 

2. The attached power device is not 802.3af-2003 
or Cisco In-Line powering compliant. Make 
sure that the attached device meets either of 
these standards, and the cabling is terminated 
to support these. Alternatively try connecting 
the device to another port to see if it powers 
on. 

3. The port Administration Control setting is set to 
OFF in the DPoE™ Element Manager. The 
DPoE™ Element Manager must be used to set 
the port Administration Control to ON. (See 
page 40, Edit Port Information, for more info.) 

The DPoE™ Compact 8 Midspan SYSTEM LED 
stays solid red after power is connected and over 
20 seconds has elapsed. 

1. Check the physical connection of the keyed 
power connector. Insure that the DC 
connection is properly mated to the power 
midspan’s power receptacle. 

2. The power supply voltage is either less than 46 
volts or greater than 57 volts. The panel should 
be immediately disconnected from power and 
the input power should be verified that it is 
operating in the correct range.   

The DPoE™ Compact 8 Midspan is providing 
power to the Powered Device (PD), but there is 
no data connection (i.e., the Ethernet connection 
is not working).  

1. The switch is not properly connected to the RJ-
45 jacks on the front of the power midspan or 
the switch. Check for proper connections are 
established or reset the connection if required. 

2. The switch port may not be active. Check with 
the local IT person to verify and correct it. 
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Problem Possible Causes and Solutions 
The DPoE™ Compact 8 Midspan continues 
supplying Power over Ethernet during firmware 
updates.  During a firmware update, and upon the 
rare occasion of multiple disconnection and 
reconnection (at least three instances) of a 
powered device (PD) the DPoE™ Compact 8 
Midspan processor may continuously roll in 
disconnect traps. 

 
1. The continuous disconnect traps can simply be 

fixed by disconnecting and reconnecting the 
powered device. 

 
Table 16: PANDUIT Contact Information 

 
PANDUIT Customer Service Phone: 800-777-3300 

E-mail: cs@panduit.com 
For Installation Instructions in Local 
Languages and Technical Support  http://www.panduit.com/Support/Software/index.htm 

Worldwide Subsidiaries and Sales Offices http://www.panduit.com/default.asp 
 

http://www.panduit.com/Support/Software/index.htm�
http://www.panduit.com/default.asp�
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GLOSSARY 
 
802.3af IEEE standard for Data Terminal Equipment 

Power Via Media Dependent Interface 
  

AWG American Wire Gauge  
DHCP Dynamic Host Configuration Protocol  
DPoE™ Panduit registered trade mark for Data & 

Power over Ethernet 
 

DTE Data Terminal Equipment   
IEEE Institute of Electrical and Electronic Engineers  
IP Internet Protocol  
LED Light-Emitting Diode  
MAC Media Access Control  
MDI Media Dependent Interface   
MHz Megahertz  
NIC Network Interface Card  
NMS Network Management System  
o.d. Outside Diameter  
PC Personal Computer  
PD Powered Device  
PoE Power Over Ethernet  
PSE Power Sourcing Equipment  
SMTP Simple Mail Transfer Protocol  
SNMP Simplified Network Management Protocol  
UPS Uninterruptible Power Supply  
 v2c SNMP Version 2c Communications  
 v3 SNMP Version 3 Communications  
VDC Volts – Direct Current  
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APPENDIX - TFTP SERVER INSTALL 
 
There are many excellent TFTP Servers readily available on the Internet that run on all types of computer 
platforms: Windows, Linux, DOS, Mac, etc. 
 
Here is a list of TFTP servers that run on the Windows Operating System:  
 
Vendor Price Link 
Solar 
Winds 

Freeware http://www.solarwinds.net/products/freetools/index.aspx#TFTPServer 

3Com Freeware ftp://ftp.3com.com/pub/utilbin/win32/3cs117.zip 
Weird 
Solutions 

Shareware http://www.weirdsolutions.com/weirdSolutions/files/products/ 
desktopSoftware/desktopTftp/tftp_desktop_free.exe 

WinAgents 30-day 
Trial 

http://www.winagents.com/en/products/tftp-server/index.php 

 
For this application note, we will use the free Solar Winds TFTP server. 
 
Go to the Solar Winds website listed in the table above, and download the free TFTP server. 
Go to the file (SolarWinds-TFTP-Server.exe) and execute this install program (double-click). 
 

 
 
Click “Next” 
 

http://www.solarwinds.net/products/freetools/index.aspx#TFTPServer�
ftp://ftp.3com.com/pub/utilbin/win32/3cs117.zip�
http://www.weirdsolutions.com/weirdSolutions/files/products/desktopSoftware/desktopTftp/tftp_desktop_free.exe�
http://www.weirdsolutions.com/weirdSolutions/files/products/desktopSoftware/desktopTftp/tftp_desktop_free.exe�
http://www.winagents.com/en/products/tftp-server/index.php�
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Click “Yes” 
 
 

 
 
Click “Next” 
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Click “Finish” 
 
 
Now run the program.  Move your mouse to the Start Menu (lower left corner): 
Start Menu-> All Programs -> Solar Winds Free Tools -> TFTP Server 
 
 

 
 
Go to the “File -> Configure” menu 
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Select the directory that contains the new DPoE product file. (i.e. C:\tftp_dir) 
 
 
That is it!  Your TFTP server has now been configured correctly.  After the download works you will see 
something like this on the screen that shows the file transfer. 
 

 
 
Note: If you are using a TFTP server from another vendor, they may have some user settable 
options.  If available, please set the timeout to 2 seconds and the maximum retransmits to 20.  
The Solar Winds TFTP server does not make these settings available to the user.  
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